
Table of Contents
Introduction.........................................................................................................................................................2
Target audience....................................................................................................................................................2
Experimental warning.........................................................................................................................................2
UnityEngine.MemoryProfiling API does not work in some Unity versions.......................................................2
Contact.................................................................................................................................................................3
Can I use this tool even when I work on a commercial project?.........................................................................3
Heap Explorer <> Memory Profiler Comparison................................................................................................4
How to install Heap Explorer..............................................................................................................................5
How to capture a memory snapshot....................................................................................................................6
Brief Overview....................................................................................................................................................8
Compare Memory Snapshots..............................................................................................................................9
C# Objects.........................................................................................................................................................10
C# Object Inspector...........................................................................................................................................12
References / Referenced by...............................................................................................................................16
Root Path...........................................................................................................................................................17
C# Object Duplicates.........................................................................................................................................19
C# Delegates......................................................................................................................................................20
C# Delegate Targets...........................................................................................................................................22
C# Static Fields.................................................................................................................................................23
C# Memory Sections.........................................................................................................................................25
C++ Objects.......................................................................................................................................................26

Exclude NativeObject connections...............................................................................................................29
C++ Asset Duplicates (guessed)........................................................................................................................30
Observations......................................................................................................................................................32
Known Unity Issues..........................................................................................................................................34
Feedback & Questions on Unity Memory Profiling API..................................................................................39
Changelog..........................................................................................................................................................40

1



Introduction
Heap Explorer is a memory profiler, debugger and analyzer for Unity.

I spent quite some time identifying and fixing memory leaks, as well as looking for memory optimization 
opportunities in Unity applications in the past. During this time, I often used Unity’s MemoryProfiler and 
while it’s a useful tool, I never was entirely happy with it.

I then decided to write my own memory profiler, that helps me in future projects to achieve my work more 
easily and faster.

Target audience
Heap Explorer is a tool for programmers and people with a strong technical background, who are looking for 
a tool that helps them identifying memory issues and memory optimization opportunities in Unity 
applications.

Heap Explorer is not fixing memory leaks, nor optimizing content for you automatically. Heap Explorer is a 
tool whose data you have to interpret and draw your own conclusions from.

Experimental warning
Heap Explorer uses Unity’s experimental MemoryProfiling API, which contains various bugs, from 
cosmetics to major issues that make memory snapshots not trustworthy. These bugs occur in every 
application that make use Unity’s MemoryProfiling API, such as Unity’s own MemoryProfiler tool and are 
not limited to Heap Explorer. I reported all bugs I found and hope Unity Technologies is able to fix them.

UnityEngine.MemoryProfiling API does not work in some 
Unity versions
Unity 2017.3 and earlier are not supported by Heap Explorer on purpose.

The MemoryProfiling API does not work in Unity 2017.4-2018.2 with Scripting Runtime .NET 4.x.

Unity 2017.4.6f1 and later 2017.4 releases work with Scripting Runtime .NET 3.5.

Unity 2018.2.6f1 works with Scripting Runtime .NET 3.5.

Please see the Known Issues section in this document to get an idea of the existing Memory Profiling API 
issues I found (there are probably more).
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https://bitbucket.org/Unity-Technologies/memoryprofiler


Contact
You can get in touch with me via the Unity forums or email. 

Post in the Heap Explorer thread:

https://forum.unity.com/threads/wip-heap-explorer-memory-profiler-debugger-and-analyzer-for-
unity.527949/

Use the “Start a Conversation” functionality to contact me via the forum: 
https://forum.unity.com/members/peter77.308146/

Can I use this tool even when I work on a commercial 
project?
Yes, you can use Heap Explorer to debug, profile and analyze your hobby-, indie- and commercial 
applications for free. You do not have to pay me anything.

If Heap Explorer helped you, I would definitely appreciate a mentioning in your credits screen. Something 
like “Heap Explorer by Peter Schraut” would be very much appreciated from my side. Again, this is not 
required at all.

You can use Heap Explorer for free, without having to give me credit or mention you used the tool at all.
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Heap Explorer <> Memory Profiler Comparison
The following table shows which features or functionality is available or missing in either tool. The table 
lists, what I believe are, the most important differences between the two tools.

Both tools provide functionality to capture a memory snapshot and inspect all it’s data, but there are a few 
differences that I would like to point out.

Feature Heap Explorer Memory Profiler

Load/save Snapshot as JSON  

Load/Save Snapshot as binary  

Compare Snapshots  

Search and Sort (by name, type, etc)  

List Memory Sections  

List C# Object Duplicates  

Inspect value and reference type objects  

Inspect 2D and 3D (jagged) arrays  

Inspect value types in arrays  

Show all Paths to Root of a C# object  

There are other features in Heap Explorer that don’t exist in Memory Profiler, but I don’t think it’s necessary 
to list them all in the table. Please read through this documentation to get an idea what Heap Explorer can do 
for your instead.
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How to install Heap Explorer

Download the latest version from:
http://www.console-dev.de/bin/heapexplorer.zip

Once downloaded, extract to the zip archive to any location under “Assets/” in your Unity project. 

I recommend to extract the zip archive to “Assets/Editor/”. This will install Heap Explorer to “Assets/Editor/
HeapExplorer”

Once Heap Explorer is extracted/copied to this location, Unity will recompile the project and afterwards you 
can open it from Unity’s “Window > Heap Explorer” menu item.

In order to uninstall/remove the Heap Explorer, simply delete the “Assets/Editor/HeapExplorer” directory.
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How to capture a memory snapshot
Heap Explorer displays the connected Player in the “Capture” drop-down, which you can find in the toolbar. 
The button is located under a drop-down menu, to avoid clicking it by accident. 

If no Player is connected, Heap Explorer displays “Editor”. Clicking the “Editor” button then captures a 
memory snapshot of the Unity editor.

If a Player is connected, Heap Explorer displays the Player name, rather than “Editor”. It’s the same name 
that appears in Unity’s Profiler window.

In order to connect to a certain target, you have to use Unity’s Profiler, as shown below. As you select a 
different target (Editor, WindowsPlayer, …) in Unity’s Profiler window, Heap Explorer will update its entry 
in the “Capture” drop-down accordingly, depending on what is selected in Unity’s Profiler.
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Why can’t I select the profiling target in Heap Explorer directly?

The Unity Editor API does not provide public functionality to implement this. It does expose some of the 
needed functionality in an unsupported namespace only. I don’t want to use unsupported and internal API’s, 
because I know from past experience, this is going to cause trouble in the long run, such as breaking the tool 
with several Unity updates.
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Brief Overview
The Brief Overview page shows you various important facts of the memory snapshot in a compact fashion. 

This includes the memory used by the top 20 native and managed objects, as well as the fragmentation of the 
managed heap in the operating system memory.
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Compare Memory Snapshots
Heap Explorer supports to compare two memory snapshots and lists the difference between those. This is a 
useful tool to find memory leaks.

“A” and “B” represent two different memory snapshots. The “delta” columns indicate changes. The “C# 
Objects” and “C++ Objects” nodes can be expanded to see which objects specifically cause the difference.

Snapshot “A” is always the one you loaded using “File > Open Snapshot” or captured. While “B” is the 
memory snapshot that is used for comparison and can be replaced using the “Load...” button in the Compare 
Snapshot view.
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C# Objects
The C# Objects view displays managed objects found in a memory snapshot. Object instances are grouped 
by type. Grouping object instances by type allows to see how much memory a certain managed object type is
using.

The view contains the main list (top-left panel) that contains all managed objects, an inspector (top-right 
panel) that displays the fields and field-values of the selected object, one or multiple paths to root (bottom-
right panel) of the selected object as well as what objects the selected object references and is referenced by 
(bottom-left panel).

Left-click on a column to sort. Right-click on a column header to toggle individual columns.
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C# Type The managed type of the object instance, such as System.String.

C++ Name If the C# object has a C++ counter-part, basically C# types that derive from 
UnityEngine.Object have, the name of the C++ native object is displayed in this 
column (UnityEngine.Object.name). 

Size The amount of memory a managed object or group of managed objects is using.

Count The number of managed objects in a group.

Address The memory address of a managed object.

Assembly The assembly name in which the type lives.
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C# Object Inspector
The C# Object Inspector displays fields of a managed object, along with the field type and value. I tried to 
mimic the feel of Visual Studio’s Watch window.
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The arrow in-front of the Name indicates that the field provides further fields itself, or in the case of an array,
provides array elements. Click the arrow to expand, as shown below.

The icon in-front of the Name represents the “high-level type” of a field, such as: ReferenceType, ValueType,
Enum and Delegate. If the field is a ReferenceType, a button is shown next to the Name, which can be used 
to jump to the object instance.

A magnification icon appears next to the value, if the type provides a specific “Data Visualizer”.  A data 
visualizer allows Heap Explorer to display the value in a more specific way, tailored to the type, as shown 
below.
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If a field is a pointer-type (ReferenceType, IntPtr, UIntPtr), but it points to null, the field is grayed-out. I 
found this very useful, because you often ignore null-values and having those grayed-out, makes it easier to 
skip them mentally.

The eye-like icon in the top-right corner of the Inspector can be used to toggle between the field- and raw-
memory mode. I don’t know how useful the raw-memory mode is for you, but it helped me to understand 
object memory, field layouts, etc while I was developing Heap Explorer. I thought there is no need to remove
it.
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References / Referenced by

The “References” and “Referenced by” panel shows what objects are connected.

For example, consider the following class:

class MeshFilter
{
    public Mesh mesh;
}

From the perspective of the MeshFilter, the “mesh” object is considered a “Reference”. From the perspective 
of the “Mesh”, the “MeshFilter” is shown as “Referenced by”.
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Root Path

The Root Path panel is used to show the root paths of an object instance. A root path is the path of referrers 
from a specific instance to a root. A root can, for example, be a Static Field, a ScriptableObject, an 
AssetBundle or a GameObject.

The root path can be useful for identifying memory leaks. The root path can be used to derive why an 
instance has not been garbage collected, it shows what other objects keep the instance in memory.

The Root Path View lists paths to static fields first, as those are often the cause why an instance has not been 
garbage collected. It then lists all paths to non-static fields. The list is sorted by depth, meaning shorter paths 
appear in the list first. Therefore, the "Shortest Path to Root" is shown at the top of the list.

In the example above, Dictionary<Int32,Boolean> is kept in memory, because PerkManagerInternal holds a 
reference to it. Finally, the static field PerkManager holds a reference to the PerkManagerInternal object.

If you select a root path, the reason whether an object is kept in memory, is shown in the info message field 
at the bottom of the Root Path View.

Some types display a warning icon in the Root Path View. This is an indicator that this object is not 
automatically unloaded by Unity during a scene change for example.

Unity allows to flag UnityEngine.Object objects to prevent the engine from unloading objects automatically. 
This is can be done, for example, using HideFlags or DontDestroyOnLoad. The Root Path view displays a 
warning icon next to the type name, if an object is either a static field or uses one of Unity's mechanism to 
prevent it from being unloaded automatically.
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C# Object Duplicates
The C# Object Duplicates View analyzes managed objects for equality. If at least two objects have identical 
content, those objects are considered duplicates.

The view groups duplicates by type. If a type, or group, occurs more than once in this view, it means it’s the 
same type, but different content.

For example, if you have 10 “Banana” strings and 10 “Apple” strings, these would be shown as two 
“System.String” groups. Two string groups, because both are of the same type, but with different content.

The view can be sorted by various columns. The most interesting ones likely being “Size” and “Count”. 

Sorting the view by “Size” allows to quickly see where most memory is wasted due duplicated objects.
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C# Delegates
Delegate’s often seem to be the cause of a memory leak. I found it useful to have a dedicated view that shows
all object instances that are of type System.Delegate.

The C# Delegates View is doing exactly this and behaves just like the regular C# Objects view. It lists all 
object instances that are a sub-class of the System.Delegate type.

If you select a delegate, its fields are displayed in the inspector (top-right corner of the window) as shown in 
the image below.
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“m_target” is a reference to the object instance that contains the method that is being called by the delegate. 
“m_target” can be null, if the delegate points a static method.

Want to help?

I would really like to display the actual method name of the field “method”. However, I didn’t find a way 
how I would look up the name using just its address. It would be a very useful feature imo. If you know how 
to do that, please let me know!

https://forum.unity.com/threads/packedmemorysnapshot-how-to-resolve-system-delegate-method-
name.516967/
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C# Delegate Targets
The C# Delegate Targets View displays managed objects that are referenced by the “m_target” field of a 
System.Delegate. The view behaves just like the regular C# Objects view.

Having a dedicated Delegate Targets view allows to quickly see what objects are held by delegates.
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C# Static Fields
The C# Static Fields view displays managed types that contain at least one static field. Selecting a type 
displays all of its static fields in the inspector (top-right corner).

Why is a static type missing?

According to my tests, static field memory is initialized when you first access a static type. If you have
a static class in your code, but it is missing in the memory snapshot, it’s likely that your application 
did not access this class yet.

Why does it not display an “Address” column?

Unity’s MemorySnapshot API does not provide at which memory address static field data is located.

Where is the Root Path view?

Static fields itself represent a root. There is no need for the Root Path view, because every static type 
is a root object.

Where is the “Referenced By” view?
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You can’t reference a static field. However, static fields can reference other objects, that’s why it 
shows the “References” view.
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C# Memory Sections
The C# Memory Sections view displays heap sections found in the memory snapshot. 

This view shows how many of those memory sections exist, which gives you an idea of how memory is 
fragmented. Select a memory section in the left list, to see what objects the sections contains, which are 
shown in the list on the right.
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C++ Objects
The C++ Objects view displays native UnityEngine objects found in a memory snapshot.

Unity offers little information of native objects, unfortunately. While it does provide the size of objects, a lot 
of data that would be interesting is missing, such as the width/height of a texture for example.

The view has pretty much the same features as the C# Objects view, but it does not provide functionality to 
inspect native object properties, beside the few ones Unity provides.

The view features the main list that contains all native UnityEngine objects (top-left), the limited information
about the selected object in the top-right panel, root paths (bottom-right) and which objects it references and 
is referenced by.

Here is what the C++ objects view displays.

Name Description

Type The type of a native object.

Name The name of anative object. This what you can query
using UnityEngine.Object.name

26



Size The size of a native UnityEngine object that it 
consumes in memory.

Count The number of native objects of the same type.

DDoL Has this object has been marked as 
DontDestroyOnLoad? 

Persistent Is this object persistent? (Assets are persistent, 
objects stored in scenes are persistent, dynamically 
created objects are not) 

Address The memory address of the native C++ object. This 
matches the "m_CachedPtr" field of 
UnityEngine.Object. 

InstanceID The UnityEngine.Object.GetInstanceID() value. 
From my observations, positive id’s indicate 
persistent objects, while negative id’s indicate objects
created during runtime.

IsManager Is this native object an internal Unity manager 
object? 

HideFlags The UnityEngine.Object.hideFlags this native object 
has. 

Major Unity bug?!

Native objects often contain hundreds of millions of references to thousands of completely unrelated objects. 
I’m pretty sure this a bug in the Unity editor or engine and reported it as Case 987839:

https://issuetracker.unity3d.com/issues/packedmemorysnapshot-unexpected-connections-between-native-
objects

The following forum post, shows an actual real example of the problem. Unity creates a connection array of 
509.117.918  elements.

https://forum.unity.com/threads/wip-heap-explorer-memory-profiler-debugger-and-analyzer-for-
unity.527949/page-2#post-3617188

Here is another post in the Profiler forum, which sounds pretty much like the same issue.

https://forum.unity.com/threads/case-1115073-references-to-native-objects-that-do-not-make-sense.608905/
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Exclude NativeObject connections

In order to workaround the major connections bug I described in the read box above this text, where Unity 
provides more than five hundred million connections, I implemented a feature in Heap Explorer to exclude 
native object connections.

Unity still captures those connections, but Heap Explorer will not process most of them. While this means 
Heap Explorer isn’t able to show which native object are connected, it’s perhaps still better than not being 
able to capture a snapshot at all.

You can active this option from Heap Explorer’s “File > Settings” menu. The option is called “Exclude 
NativeObject connections”.

Only active this option, if you see Heap Explorer running in this error:

HeapExplorer: Failed to allocate 'new PackedConnection[]'.
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C++ Asset Duplicates (guessed)
The “C++ Asset Duplicates” view is guessing which asset might be duplicates. Unity Technologies explains 
how to guess if two assets are duplicates on this page:

https://docs.unity3d.com/Manual/BestPracticeUnderstandingPerformanceInUnity2.html

The idea is, if you have two assets of the same type and name, but with different instanceID’s, these could be 
duplicates. This approach is of course everything else than reliable, but perhaps better than nothing. 
Therefore, I implemented this view in Heap Explorer.

The assumption falls apart as soon as the project contains more than one asset with the same name of the 
same type. For example, if you follow a project structure like shown below, Heap Explorer shows incorrect 
results.

Asset Duplicate Detection Limitation

Heap Explorer incorrectly detects these textures as duplicates, because they have the same name:

Assets/Characters/Alien_01/Texture.tga
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Assets/Characters/Alien_02/Texture.tga

Assets/Characters/Alien_02/Texture.tga

Message to Unity Technologies

It would be very useful if you store additional information in a “development mode” build, to be able to map 
a native UnityEngine object in a MemorySnapshot to its asset guid in the project for example. This would 
allow tools such Heap Explorer to implement some powerful functionality. This additional information 
should be stripped in non-development builds.
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Observations

In this section, I’m going to list a few things I observed while working on Heap Explorer and studying many 
memory snapshots.

String duplicates

Unity does not seem to share string memory.

Even if two strings have the same text, the text exists in memory twice. This is very noticeable in various 
UnityEngine.UI Components, that seem to use strings a lot, such as function binding for example.

I found many UI heavier games contain thousands of string duplicates that all originate from Unity’s UI 
system, such as:

UnityEngine.UI.MaskableGraphic+CullStateChangedEvent, UnityEngine.UI, Version=1.0.0.0, 
Culture=neutral, PublicKeyToken=null

Zero Size Array (new T[0])

I found many projects contain fields of type List<T> and T[], but those collections often do not contain any 
elements, they have a size of 0.

Fields exposed to the Inspector seem to be created by Unity automatically. I guess, it’s a feature to allow you 
to edit the value, even if you do not create that object instance yourself in code.

However, what this is causing is that you might believe these fields are null and don’t consume any memory.

In reality, projects often seem to contain thousands of zero size array’s (new T[0]). Please be aware that an 
empty array still consumes memory, due to its header. If you have thousands of zero size array’s, you might 
waste memory.

Some famous asset store plugin(s) pull in tens-of-thousands of empty arrays.
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UnityEngine.Events.UnityEventBase

In UI heavier projects, this type seems to cause a lot of string duplicates and zero size arrays.

It contains an InvokableCallList field named m_Calls, which itself contains three List<>’s 
(m_PersistentCalls, m_RuntimeCalls, m_ExecutingCalls), which seem in most cases to have no elements.

The m_TypeName string field points in many cases to duplicated strings.
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Known Unity Issues
While working on Heap Explorer, I found various issues in Unity’s Memory Profiling API:
https://docs.unity3d.com/ScriptReference/MemoryProfiler.MemorySnapshot.html

These issues are not limited to Heap Explorer, they are Unity editor/engine problems. Every tool, such as 
Unity’s own Memory Profiler, is suffering from these issues as well.

The “Status” column indicates with which version I retested the issue after I submitted the original bug-
report, which was confirmed as a bug by Unity Technologies.

Status Case Description Link

2018.3.0f2 = FAIL 1115544 Array type 'baseOrElementTypeIndex' does not 
point to its element type, when using .NET 4.x 
Scripting Runtime.

https://forum.unity.com/
threads/case-1115544-
array-type-
baseorelementtypeindex-
does-not-point-to-its-
element-type.609922/

2018.3.0b11 = FAIL

Closed bug with 
“By Design”

1104590 "subSystemList" detected with wrong type https://forum.unity.com/
threads/case-1104590-
packedmemorysnapshot-
subsystemlist-detected-
with-wrong-type.589420/

2017.4.10f1 = FAIL

Closed bug with 
“Duplicate” without
providing a link to 
the duplicate.

1104581 Missing "subSystemList" field https://forum.unity.com/
threads/case-1104581-
packedmemorysnapshot-
missing-subsystemlist-
field-in-playerloopsystem-
typedescripti.589405/

2017.4.10f1 = FAIL
2018.3.f02 = OK

1079363 typeDescriptions, gcHandles, 
managedHeapSections arrays are empty in 
memory snapshot when using .NET 4.x 
Scripting Runtime.

https://
issuetracker.unity3d.com/
product/unity/issues/guid/
1079363

2017.4.6f1 = OK 1034172 "typeDescriptions" array is empty in memory 
snapshot when using .NET 3.5 Scripting 
Runtime.

https://
issuetracker.unity3d.com/
issues/snapshot-dot-
typedescriptions-dot-
length-returns-zero-when-
taking-a-
packedmemorysnapshot-
snapshot
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2017.4.6f1 = OK 973872 Fields of generic types, such as List<T>, are 
missing in memory snapshot.

2017.4.6f1 = OK 974031 Leading period symbol in Typename https://
issuetracker.unity3d.com/
issues/
packedmemorysnapshot-
leading-period-symbol-in-
typename

2017.4.6f1 = OK 974042 Nested types lack type of parent https://
issuetracker.unity3d.com/
issues/
packedmemorysnapshot-
nested-types-lack-type-of-
parent

2017.4.6f1 = FAIL 975832  Missing connections between native objects https://
issuetracker.unity3d.com/
issues/
packedmemorysnapshot-
missing-connections-
between-native-objects

2017.4.6f1 = OK 977003 Unable to resolve typeDescription of 
GCHandle.target

https://
issuetracker.unity3d.com/
issues/
packedmemorysnapshot-
unable-to-resolve-
typedescription-of-
gchandle-dot-target

FAIL 977938 RequestNewSnapshot freezes editor for some 
time

https://
issuetracker.unity3d.com/
issues/
packedmemorysnapshot-
requestnewsnapshot-
freezes-editor-for-a-bit

2018.2.0a3 = OK
2017.4.6f1 = FAIL

983804 ScriptableObject recognized as MonoBehaviour https://
issuetracker.unity3d.com/
issues/scriptableobject-is-
recognized-as-
monobehaviour-in-the-
snapshot-dot-nativetypes-
array

2017.4.6f1 = FAIL 984330 Type contains staticFieldBytes memory, but https://
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actually has no static field issuetracker.unity3d.com/
issues/
packedmemorysnapshot-
type-contains-
staticfieldbytes-but-has-
no-static-field

2017.4.6f1 = OK 984704 Incorrect name for generic types https://
issuetracker.unity3d.com/
issues/
packedmemorysnapshot-
incorrect-name-for-
generic-types

FAIL BY DESIGN?

I believe Unity 
didn’t invest enough
time to understand 
the problem.

987839 Unexpected connections between native objects.

The “connections” array in a snapshot holds 
connections between native objects that hardly 
make sense, such as an “AudioSource” connects
to a “Mesh”.
https://forum.unity.com/threads/wip-heap-
explorer-memory-profiler-debugger-and-
analyzer-for-unity.527949/page-2#post-3619123

https://
issuetracker.unity3d.com/
issues/
packedmemorysnapshot-
unexpected-connections-
between-native-objects

2017.4.6f1 = FAIL 987987 "snapshot.managedHeapSections" do not match 
stats in Profiler

https://
issuetracker.unity3d.com/
issues/
packedmemorysnapshot-
managedheapsections-do-
not-match-stats-in-profiler

2018.2.0b9 = FAIL 

2017.4 = No 
NativeArray 
support

989622 NativeArray memory missing in snapshot https://
issuetracker.unity3d.com/
issues/
packedmemorysnapshot-
nativearray-memory-is-
not-captured-in-it

2017.4.6f1 = FAIL 989625 ExecutableAndDlls memory is missing in 
snapshot

https://
issuetracker.unity3d.com/
issues/executableanddlls-
is-not-found-when-
checking-through-a-
packedmemorysnapshot

2017.4.6f1 = OK 993250 Calling RequestNewSnapshot method causes 
Player to crash
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2017.4.6f1 = FAIL 993295 Various fields are missing in types when 
capturing a snapshot from a Player.
It seems many fields of an enum type are 
missing.

https://
issuetracker.unity3d.com/
issues/
packedmemorysnapshot-
missing-fields-in-player

2017.4.6f1 = FAIL 998707 "delegates" field missing in "MulticastDelegate"
type

https://
issuetracker.unity3d.com/
issues/
packedmemorysnapshot-
delegates-field-missing-in-
multicasedelegate-type

2017.4.6f1 = FAIL 1008321 Editor freezes if Profiler is unable to connect to 
Player

https://
issuetracker.unity3d.com/
issues/editor-freezes-if-
profiler-is-unable-to-
connect-to-player

2017.4.6f1 = OK 1008392 Editor crash while taking 
PackedMemorySnapshot in "CopyHeapSection"

https://
issuetracker.unity3d.com/
issues/editor-crash-while-
taking-
packedmemorysnapshot-
in-copyheapsection

2017.4.6f1 = OK 998728 Editor window becomes unresponsive when 
using UnityEditor.IMGUI.Controls.TreeView 
for a while

https://
issuetracker.unity3d.com/
issues/unityeditor-dot-
imgui-dot-controls-dot-
treeview-becomes-
unresponsive-if-it-
contains-many-items

2018.2.0b9 = FAIL
2017.4.6f1 = FAIL

1052281 Keyboard navigation in 
UnityEditor.IMGUI.Controls.TreeView 
becomes unresponsive if the treeview contains 
many items

https://forum.unity.com/
threads/case-1052281-
imgui-controls-treeview-
keyboard-navigation-is-
slow.537468/

2018.2.0b9 = FAIL
2017.4.6f1 = FAIL

1052308 nativeObject.isPersistent flag or its 
documentation is wrong

https://forum.unity.com/
threads/case-1052308-
packedmemorysnapshot-
nativeobject-ispersistent-
or-documentation-
incorrect.537484/
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Empty C# Memory Sections

Some memory sections in the C# Memory Sections view do not contain any references to any objects, but if 
you look at their raw-memory, you see that it actually contains non-zero content.

This is caused by C# Static Fields memory being stored in managed heap sections as well. Unfortunately, the 
information Unity provides regarding staticFieldBytes is very limited in their Memory Profiling API.

A PackedMemorySnapshot contains for every managed type an array, that represents the memory that is used
to store the static fields memory, named staticFieldBytes. Unfortunately, it does not provide at which address 
in the managed heap this would be located.

Additionally, the staticFieldBytes are also stored across the managed memory sections.

Due to missing functionality in the PackedMemorySnapshot, I’m unable to resolve what staticFieldBytes are 
stored in which MemorySection.

Which means, if a MemorySection contains staticFieldBytes, I’m unable to detect this and can’t visualize it 
in Heap Explorer.

I haven't submitted a bug-report for this yet.
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Feedback & Questions on Unity Memory Profiling API

PackedMemorySnapshot: Missing Unity version and platform information
https://feedback.unity3d.com/suggestions/packedmemorysnapshot-missing-unity-version-and-platform-
information

MemoryProfiler: Unexpected NativeUnityEngineObject size
https://forum.unity.com/threads/memoryprofiler-unexpected-nativeunityengineobject-size.519715/

PackedMemorySnapshot: How to resolve System.Delegate method name?
https://forum.unity.com/threads/packedmemorysnapshot-how-to-resolve-system-delegate-method-
name.516967/
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Changelog

Beta 3.1 (February 13th, 2019)
 The bottom status bar now display the loaded snapshot filepath. Suggested here.

Beta 3.0 (January 7th, 2019)
 Added option to hide internal managed managed sections (sections that are not 4096bytes aligned), as

explained here. You can toggle this behavior in the toolbar “File > Settings > Show Internal Memory 
Sections”.

 Added functionality to substitute managed object addresses from a text file to Heap Explorer. This 
was an attempt to debug why a managed object exists in memory at run-time, but is not included in a 
memory snapshot. You can follow the problem here.

Beta 2.9 (November 28th, 2018)
 Added workaround for Unity bug Case 1104590. Heap Explorer now ignored what appears as nested 

struct instances, which was causing an endless loop. This issue occurs with .NET4 ScriptingRuntime 
only. You can find the option to toggle this behavior in HeapExplorer toolbar > File > Settings > 
Ignore Nested Structs. Based on this feedbac.

 Increased loop guard limit, when trying to find root paths from 100000 to 300000 iterations. This 
avoids this issue.

 Added functionality to cancel a “finding root paths” operation. A “Cancel” button is now available in 
the root paths panel.

 When changing the selection in the C#/C++ objects view, any running “finding root paths” job is 
aborted, rather than waited for completion. This makes the UI feel more responsive.

 Changed order in which various jobs run in Heap Explorer, which makes the UI slightly more 
responsive.

Beta 2.8 (November 25th, 2018)
 Added functionality to stop/cancel a processing step when Heap Explorer is analyzing a memory 

snapshot. This is actually a workaround for an issue that sounds like an infinite loop as reported here. 
I’m still interested in the memory snapshot that causes the issue to actually fix it though.

 C# Memory Sections View: Added raw memory view to inspect the actual bytes of a memory section.
 C# Memory Sections View: Changed phrase "N memory sections fragmented across X.XXGB" to "N

memory sections within an X.XXGB address space", based on this feedback.
 Overview View: Removed memory sections graph, based on this feedback.
 Added functionality to export parts of the memory snapshot to CSV. You find it in the “Views” popup

menu, named “CSV Export”. Based on this feedback.
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Beta 2.7 (September 9th, 2018)
 Added warning if project uses .NET 4.x Scripting Runtime, because Unity’s MemoryProfiling API 

does not work with that at the time of writing. See here for details.
 Added better error messages for known memory snapshot issues, like empty typeDescriptions array.
 Added error message dialog and then quit Heap Explorer if an unrecoverable error occurrs.
 Added error message if Heap Explorer is unable to parse the editor version, to get at the bottom of 

this problem.

Beta 2.6 (September 2nd, 2018)
 Added “Exclude NativeObject connections when capturing a memory snapshot” option to Heap 

Explorers “File > Settings” menu. Please read the “Exclude NativeObject connections” 
documentation when you might want to activate it.

Beta 2.5 (August 28th, 2018)
 Added Debug.Log if the PackedConnection array creation would cause an out-of-memory exception. 

See this forum post.

Beta 2.4 (August 11th, 2018)
 Overview View: Fixed  negative size display if object group exceeded the maximum int limit.
 C++ Objects View: Fixed negative size display, if an object group exceeded the maximum int limit.
 C# Objects View: Fixed negative size display, if an object group exceeded the maximum int limit.
 Memory Sections: Fixed saving memory sections as file which are larger than 2gb.
 Loading memory snapshots displays more information about the progress now.

Alpha 2.3 (June 7th, 2018)
 C++ Objects View: Added asset preview. Memory snapshots do not contain asset memory, thus the 

preview is generated from the asset in the project instead rather than the memory snapshot!
 C++ Objects View: Reworked list filtering. It allows to change filter settings without the list being 

recreated every time you change a single option. You have to apply those changes now. This helps to 
save time when filtering big memory snapshots.

 C++ Objects View: If any list filtering is active, the “Filter” button in the toolbar uses a different 
color, to make it obvious filtering is in place.

 C++ Objects View: Fixed “Type” display of MonoBehaviour, which now displays the actual derived 
type rather than just MonoBehaviour always.

 C++ Objects View: Fixed “Type” column sometimes showing the object name rather than type.
 Brief Overview: Changing wording of the Memory Section description.

Alpha 2.2 (June 23rd, 2018)
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 C++ Objects View: Replaced generic “C++” icon with icons that indicate whether it’s an asset, scene-
object or run-time-object.

 C++ Objects View: Added popup menu to toolbar to exclude native objects from the list, depending 
on whether the native object is an asset, a scene-object or a run-time-object.

 C++ Objects View: Added popup menu to toolbar to exclude native objects from the list,
 depending on whether the native object is marked as “Destroy on load” or “Do NOT destroy on 

load”.
 C++ Objects View: Display icon in object inspector in the top-right corner.
 C++ Objects View: Fixed count and size display in bottom status bar.

Alpha 2.1 (June 16th, 2018)
 Added “C++ Asset Duplicates” view.
 Added context menu if you right-click the “Name” column in the C++ objects view. It provides 

functionality to find assets of the C++ object/asset name in the project,

Alpha 2.0 (May 25th, 2018)
 C# Memory Sections: Added visualization of managed memory section fragmentation

Alpha 1.9 (May 21st, 2018)
 Overview: Brought back “GCHandles” and “Virtual Machine Information”
 When loading a snapshot from the “Start Page”, it opens the “Brief Overview” afterwards, rather than

the “C# Objects” view.

Alpha 1.8 (May 21st, 2018)
 Overview: Added percentage % next to the size
 Overview: Added visualization of managed heap fragmentation in the operating system memory
 Overview: Fixed some layout issues
 Overview: Removed GCHandles and VirtualMachine Information from the overview, as this wasn’t 

very interesting nor something that is normally using much memory.

Alpha 1.7 (May 19th, 2018)
 Compare Snapshots: Added “Swap” button to swap snapshot A <> B as suggested here.
 Compare Snapshots: Snapshot B doesn’t get unloaded anymore, when loading or capturing snapshot 

A, as suggested multiple times.
 Compare Snapshots: Loading Snapshot B now displays the same loading status information as when 

loading Snapshot A.
 C# Static Fields: Added toolbar menu with functionality to save the memory of a selected static field 

as a file.
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 C# Memory Sections: Added toolbar menu with functionality to save the all C# memory sections as a 
file.

 Moved statics to bottom status bar.
 Debugged why some memory sections do not contain references to managed objects, but contain non-

zero bytes. See “Empty C# Memory Sections” in under Known Issues.

Alpha 1.6 (May 8th, 2018)
 “Compare Snapshots”, changed diff from “A - B” to “B - A” comparison. Reported here.
 Fixed being unable to select a memory section by clicking on its address in the “C# Memory 

Sections” view. Reported here.
 Loading a snapshot restores the previously active view when done. Reported here.

Alpha 1.5 (May 7th, 2018)
 Added another workaround for “Array out of index” exception.

Alpha 1.4 (May 7th, 2018)
 Added workaround for “Array out of index” exception, if the element-type of an array could not be 

detected. In this case this object outputs an error during heap reconstruction and from then on it’s 
ignored. Please send me the memory snapshot if you run into this error.

Alpha 1.3 (May 6th, 2018)
 In Heap Explorer toolbar, added “Capture > Open Profiler”. This opens the Unity profiler window, 

which allows you to connect to a different target. It’s simply a convenience feature, if you figure the 
editor is not connected to the correct player. This saves a few mouse clicks to get to the Unity Profiler
to connect to a different player.

 The “Load” button in the “Compare Snapshot” view now features a “most recently used” snapshot 
list. This allows you to switch between previously saved snapshots with fewer mouse clicks.

 In Heap Explorer toolbar, added “File > Recent”, which allows to re-open the “most recently used” 
snapshots.

Alpha 1.2 (May 5th, 2018)
 In Heap Explorer toolbar, renamed “Capture” to “Capture and Analyze”.
 In Heap Explorer toolbar, added “Capture and Save”, which just saves the captured snapshot without 

automatically analyzing it. It was suggested here.

Alpha 1.1 (May 2nd, 2018)
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 In Heap Explorer toolbar, added “Settings > Use Multi-Threading”. Previously Heap Explorer was 
using multi threading always. However, for debugging reasons it makes sense to provide an option to 
turn it off, so Unity can properly log errors to the Console window.
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